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1 ESITTELY 

Tässä ohjeessa kuvataan kuinka Dupline-Online Server palvelinohjelmaan perustuva 
energiahallintajärjestelmä otetaan käyttöön. Tässä dokumentissa on esitetty välttämättömät toimenpiteet 
järjestelmän käyttöönottamiseksi. Muita ominaisuuksia voidaan asetella ja ottaa käyttöön käyttämällä eri 
laitteiden yksityiskohtaisia käyttöohjeita. KYTKE KANAVEGENEAATTORIN APUJÄNNITE VASTA 
KÄYTTÖÖNOTON YHTEYDESSÄ. 
 
Järjestelmä on esitelty yksityiskohtaisesti dokumentissa ”Dupline-Online Server palvelinohjelma 
Asennusohjeet”. 
 

2 KÄYTTÖÖNOTON VAIHEET 

2.1 Yleistä 

Sujuvaan käyttöönottoon sisältyy tehtäviä asennuksen eri vaiheissa. Noudattamalla näitä ohjeita 
varmistutaan helposta käyttöönotosta asennusten varsinaisessa käyttöönottovaiheessa. Käyttöönotto 
muodostuu seuraavista toimenpiteistä: 
 

 mittariluettelon laadinta 

 EM24 mittareiden ohjelmointi (osoitteet, laskureiden lukumäärät, laskureiden suureet ja painoarvot) 

 EM4 ja WM22 mittareiden Dupline® -moduulien (G63910240) osoitteiden asetukset (DIP kytkimien 
asetukset) 

 laskureiden asetukset 

 Dupline –väylän tarkastaminen 

 järjestelmän kokoonpanon määrittely kanavageneraattorille ja sen siirto palvelinohjelmaan 

 ETHCONV2, ETHCONV3 tai OnCellG3110 muuntimen asetusten määrittelyt 

 Dupline-Online Server -palvelinohjelman asennus 

2.2 Tarvittavat välineet 

 Kannettava PC jossa on RS232 sarjaliikenneportti tai käytetään USB-RS232 muunninta ja mahdollisuus 
tekstitiedoston siirtoon (esim. USB, polttava CD, s-posti) 

 RS-232 kaapeli (tulee kanavageneraattorin mukana) 

 Määrittelytyökalu (tulee kanavageneraattorin mukana tai ladattavissa www.dupline-online.com/support) 
 

http://www.dupline-online.com/support
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3 LAITTEIDEN ASETUKSET  

3.1 Mittariluettelo 

Mitattavista kulutuspisteistä laaditaan luettelo, esim. excel -taulukko jossa otetaan huomioon kulutusta 
mittaavan komponentin ominaisuudet. Käytettävissä komponenteissa EM4 ja EM24 mittareissa sekä 
pulssilaskurissa G4420 osoitteen asetus tapahtuu eri tavoilla. Katso kohdasta 3.2 EM24 mittarin asetukset, 
kohdasta 3.3 EM4 ja WM22 mittarin G63910420 moduulin asetukset ja kohdasta 3.4 pulssilaskurin G4420 
7401 230 asetukset.  
Jos mittaava komponentti (mittari, laskuri) sisältää useampia laskureita on ne sijoitettava osoitetaulukossa 
peräkkäin eli peräkkäiset osoitteet, koska mittaavalle komponentille annetaan vain yksi osoite ensimmäiselle 
laskurille ja muut laskurit ovat automaattisesti seuraavilla osoitteilla. 
Esimerkiksi pulssilaskurissa on 4 tuloa, joiden osoitteet ovat 4, 5, 6 ja 7 jos laskurin kiertokytkimet ovat 
asennoissa 1 ja 1 (1-1). Pulssilaskurin ensimmäisen tulon desimaalilukuosoite on aina 0, 4, 8,12 jne eli 4:llä 
jaksollinen. 
Jos taas EM24 mittarilta halutaan esim kWh ja kVArh ja osoitteeksi asetetaan 10, niin osoitteet 10 ja 11 ovat 
käytössä.  
Tämä taulukko on pohjana mittareiden ja laskureiden osoitteiden asettamiselle ja järjestelmän määrittelylle. 
Mallitaulukkopohja on saatavissa Carlo Gavazzi Oy:stä. 
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3.2 EM24 mittarin asetukset 

3.2.1 Yleistä 

Tämä kappale kuvaa kuinka EM24 mittari ohjelmoidaan Dupline -väylään 
yhteensopivaksi mittalaitteeksi. Mittarina käytetään joko suora- (EM24DIN93XDPX) 
tai virtamuuntajaliitäntä (EM24DINAV53DDPP) mittaria joissa Dupline väylä lukee 
suoraan mittarin muistirekisteriä. 

3.2.2 Asennus 

Mittaria asennetaan mittarin asennusohjeen mukaisesti jo suoraan verkkoon (65A) tai virtamuuntajien (5A) 
välityksellä (kts. datalehti) 

3.2.3 Ohjelmointi 

Ohjelmointi tapahtuu ”JOY STICKiä” (myöhemmin JS) ja kiertokytkintä apuna käyttäen. JS:llä on 5 
eri toimintasuuntaa ↔ (vasemmalle ja oikealle), ↕ (ylös ja alas) ja painallus. Painallus toimii ns. 
”Enter” painikkeena jolla mennään muutostilaan ja vahvistetaan muutos. Muutostila ilmaistaan 
alarivin ”Prg” tekstillä, jolloin lukuarvoa voidaan muuttaa. JS:n ↔ (vasemmalle ja oikealle) 
painikkeilla edetään ohjelmointivalikossa vasemmalle tai oikealle sekä muutostilassa sillä voidaan 
siirtää numeroarvossa pilkun paikkaa. JS:n ↕ (ylös ja alas) painikkeilla muutetaan muutostilassa 
lukuarvoja sekä normaali näyttötilassa selataan eri näyttöjen sivuja. 
”JS →” TARKOITTAA   JOY STICKIN PAINALLUSTA OIKEALLE. 
 
OHJELMOINNIN ALOITUS 
Käännä vipukytkin asentoon 1. 
Paina JS muutama sekunti jolloin yläriville tulee teksti ”PASS?” ja keskiriville ”0” ja alariville ”PrG” 
Paina JS ja olet ohjelmointitilassa. 
 

VAIN VIRTAMUUNTAJAMITTARIT (SUORILLA MITTAREILLA HYPPÄÄ TÄMÄ YLI) 
Paina JS → niin monesti, että näyttöön tulee ”Ct ratio” 
Paina JS, jolloin alariville tulee ”Prg” 
Aseta JS:llä  virtamuuntajien muuntosuhde (Taulukosta tai suoraan virtamuuntajista) 
Hyväksy painamalla JS lyhyesti, jolloin ”Prg” poistuu alariviltä 
 
KAIKKI MITTARIT 
Paina JS → niin monesti, että näyttöön tulee ”duP Cnt” 
Paina JS, jolloin alariville tulee ”Prg” 
Aseta JS:llä laskureiden määräksi ”1” (oletus että 1 laskuri on käytössä) 
Hyväksy painamalla JS lyhyesti, näyttöön tulee ”Adr Cnt” 
Paina JS, jolloin alariville tulee ”Prg” 
Aseta JS:llä mittarin osoite. (Saadaan taulukosta, mittarin ensimmäisen laskurin osoite) 
Hyväksy painamalla JS lyhyesti, jolloin näyttöön tulee ”res Cnt”  ”no” 
Paina JS kaksi kertaa, jolloin näyttöön tulee ”duP Cnt.1”, valitse JS:llä ↕  ”kWh   tot” 
Paina JS kaksi kertaa, jolloin näyttöön tulee ”duP cnt” ”1” 
Paina JS → niin monesti, että näyttöön tulee ”End” 
Paina JS palataksesi normaalitilaan. 
Käännä kiertokytkin takaisin asentoon ”lukko”. 
 
Mittari on nyt ohjelmoitu ja painamalla JS:ää sivusuunnassa nähdään mittarin ohjelmointiarvot mm 
VM muuntosuhde ”Ct ratio”. Voidaan myös todeta näkeekö mittari Dupline väylän. Jos mittari 
näkee väylän tulee näyttöön ko. kohdassa teksti ”Dupline” ”oⱵ” joka tarkoittaa Dupline on.  
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3.3 Mittarimoduulin G63910240 asetukset 

3.3.1 Yleistä 

Tämä kappale kuvaa kuinka Dupline mittarimoduuli G63910240 asennetaan ja 
ohjelmoidaan. Moduuli G63910240 soveltuu käytettäväksi Carlo Gavazzin mittareiden EM4 ja WM22 kanssa. 
Moduulin avulla voidaan kaukolukea mittarin (EM4, WM22) mittaama energialukema Dupline väylän kautta.  

3.3.2 Asennus 

Moduuli asennetaan mittarin moduulipaikkaan B (oikeanpuoleinen paikka). Ennen moduulin asentamista 
mittariin suoritetaan osoitteen asetus. Asennus mittariin tulee suorittaa mittarin apujännitteen ollessa 
poiskytkettynä. 

3.3.3 Osoitteen asettaminen 

Käytettäessä Dupline väylämoduulia on mittarin sarjaliikenneportin osoitteen oltava 255. (kts.mittareiden 
käyttöohjeet) 
Osoitteen asetus mittarin moduuliin tapahtuu DIP –kytkimillä seuraavasti: 

 
DIP –kytkin 1 (ylempi rivi) 

 
 
 
 
 
 
 8 ON: sallii S0 tulon nollauksen (Aina off) 

 
 1-7 Laskurin osoite (Saadaan mittaritaulukosta) 

 
DIP –kytkin 2 (alempi rivi) 

 
Yleensä nämä asetellaan: 
on,off,off,off,off,off,off,off, jolloin vain ”kWh tot” arvo siirretään  
 
 
 
 
6-8: ei käytössä AINA OFF 
 
5 ON: Salli ”Heart beat” signaalin EI KÄYTÖSSÄ => OFF 
4 ON: Sallii S0 tulon 2 luvun YLEENSÄ OFF 
3 ON: Sallii S0 tulon 1 luvun YLEENSÄ OFF 
2 ON: Sallii kokonais loisenergian luvun (kVArh tot) YLEENSÄ OFF 
1 ON: Sallii kokonaisenergian luvun (kWh tot) AINA ON 
 

 
Osoitteet muodostetaan binäärilukujärjestelmän avulla ”dippaamalla” kytkimiä siten, että osoite 
(desimaaliluku) saadaan muodostettua 
 
 
 
Haluttu osoite valitaan sarakkeesta ”Osoite” ja sen jälkeen asetetaan DIP –kytkimet taulukon osoittamaan 
tilaan on/off. 
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Bitin 
arvo 

64 32 16 8 4 2 1  

DIP-
KYTKIN 

1 2 3 4 5 6 7  

        Osoite 

 off off off off off off off 0 

 off off off off off off ON 1 

 off off off off off ON off 2 

         

 ON ON ON ON ON ON off 126 

 ON ON ON ON ON ON ON 127 

 

3.3.4 Kytkennät 

Dupline –väylän ja ulkopuolisten pulssitulojen johtimet kytketään alla olevan kuvan ja taulukon mukaisesti.  
 

 
Counter S0 outout = ulkopuolinen pulssilähde 
43: Common = yhteinen 
42: S0 input 1 = laskuritulo 1 
41: S0 input 2 = laskuritulo 2 
44: Dupline gnd = Dupline - / maa (ei saa maadoittaa) 
45: Dupline Signal = Dupline + 
 
 
 

 

3.3.5 LED toiminnot 

Mittarimoduulin toimintaa kuvataan moduulissa olevalla keltaisella LEDillä. LEDin toiminta kertoo moduulin 
toimintatilasta ja mahdollisen vikakoodin. 
 

 

ON Moduuli kunnossa 

Lyhyt vilkku Dupline väylä puuttuu 

Hidas vilkku Virhe mittarin ja moduulin välillä 

Nopea vilkku Moduulin sisäinen virhe 
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3.4 Pulssilaskurin G4720 4401 230 asetukset 

3.4.1 Yleistä 

Tämä kappale kuvaa kuinka Dupline pulssilaskuri G44207401 asennetaan ja ohjelmoidaan. Moduuli 
G44207401 soveltuu käytettäväksi lukuisten erilaisten energia-, vesi- ja kaukolämpömittareiden kanssa 
laskemaan kulutusmittarin antamia pulsseja. Laskurin avulla voidaan kulutusmäärät siirtää Dupline -väylän 
kautta haluttuun paikkaan tai järjestelmään. 
 
Laskurin DIP –kytkimillä valitaan oikea toiminta, nollaus ja mittausalue. Kiertokytkimillä asetetaan laskurille 
yksilöllinen osoite. 

3.4.2 Kytkennät 

Alla olevassa kuvassa on esitetty laskuri apujännite-, pulssitulo- ja Dupline –väylä kytkennät. 
 
Liitinmerkinnät: 
      230VAC 
1.7 Dupline + 
1.3 Dupline – 
 
 
1.1 Apujännite 230VAC 
1.5 Apujännite 230VAC 
1.2 Pulssitulo 1 
1.6 Pulssitulo 2 
2.2 Pulssitulo 3 
2.6 Pulssitulo 4 
 
 
 
      
      

 Kuvan esimerkissä kulutusmittarin pulssilähtö on 
kytketty tuloon 1. 

  
Pulssitulon maksimi johdon pituus on 5m, jotta voidaan välttyä tulojohtimiin kohdistuvilta häiriöiltä. 
Käytettäessä 24VDC apujännitesyöttöä on syöttöjohdon pituuden oltava alle 3m. 

3.4.3 DIP –kytkimien asetukset 

Kytkimellä nro 1 määritellään sallitaanko laskuritulot nollattaviksi 
väylän kautta. (Ylleensä asetus OFF) 
 
Kytkimellä nro2 määritellään laskurin toiminta Pulssilaskenta/Ajan 
summaus (Aina OFF) 
 
Kytkimillä nro 3 ja 4 määritellään laskurin maksimi lukema. Tässä 
sovelluksessa käytetään ON ja ON. 
 
Kiertokytkimillä määritetään laskurin osoite.  
Pulssilaskurissa on 4 toisistaan riippumatonta tuloa. Tulojen osoitteet ovat neljä peräkkäistä osoitetta 
järjestelmässä joista ensimmäinen asetetaan kiertokytkimillä 1 ja 2. Loput osoitteet pulssilaskuri jakaa 
automaattisesti. Osoitetta 0 vastaa kiertokytkimien asennot 1-0, jonka jälkeen laskuri jakaa automaattisesti 

Dupline + 

Dupline - 
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tulot osoitteisiin 0,1,2 ja 3. Kiertokytkimien asennot 1-1 vastaa osoitetta 4;5;6 ja 7, asentoa 1-2=> 8;9;10 ja 
11 jne. Vertaa erillinen binääriosoitetaulukko. 

3.5 Väylän tarkastus 

Dupline –väylä tarkastetaan oikosulkujen ja vääränapaisuuskytkentöjen varalta kaksivaiheisesti. 
Asennusten edetessä varmistutaan välitarkastuksilla siitä, että väylässä ei ole oikosulkuja ja moduulien 
virhekytkentöjä. 
Kanavageneraattorin ollessa päällä voidaan moduuleista tarkistaa, että keltainen LED on jatkuvasti päällä 
jolloin moduuli ”näkee” kanavageneraattorin kantoaallon. Kanavageneraattorin väylän tilaa ilmaisevan 
keltaisen LEDin tulee palaa jatkuvasti. 

3.6 Kokoonpanonmäärittely kanavageneraattoriin 

Kanavageneraattoriin täytyy asettaa tiedot järjestelmästä ja siihen liitetyistä mittareista ja kulutuspisteistä. 
Kokoonpanomäärittely tehdään käyttämällä PC:hen asennettua konfigurointityökalua joka toimitetaan 
kanavageneraattorin mukana tai voidaan ladata internetistä osoitteesta www.dupline.com , Download, 
Configuration Software, Configuration tool G3800xxxx. Kokoonpanotiedosto voidaan tehdä valmiiksi 
esimerkiksi toimistossa etukäteen. Valmis kokoonpanomäärittely siirretään työmaalla kanavageneraattorille. 
 
Kanavageneraattorin konfiguroinnissa tarvitaan aiemmin luotua mittariluetteloa. Mittariluettelo on perustana 
tietokannalle joka syötettään kanavageneraattorille. Kokoonpanomäärittelyn lopuksi tehdään määritellystä 
kokoonpanosta tekstitiedosto joka siirretään Dupline-Online palvelinohjelmaan järjestelmän kokoonpanoksi. 

3.6.1 Aloitus 

Avaa konfigurointityökalu G3800xxxx Tool v??.??, jolloin avautuu alla oleva ikkuna. 
 

 

Valitse File=> New=>x36, jolloin on valittu kokoonpano Data Logger -pohjaiselle kanavageneraattorille. 

http://www.dupline.com/
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3.6.2 Perustiedot 

Valitse Edit=>Basic Setup. 
 

 
 
Kirjoita ”General description” -ikkunaan yleistietoa järjestelmästä, esim käyttäjän nimi, kohdetietoja, 
konfiguroinnin päivämäärä ym. Merkit ”/”, ”\”, ”:” ja ”–” eivät ole sallittuja. Tähän kirjoitetusta tekstistä tulee 
osa konfigurointitiedoston tallennusnimeä. 
 
Tarkista, että valintaikkunassa ”No.of Addresses” on valittu 128. 
 
Aseta päälle toiminnot ”Enable automatic Update…”, Enable Autoamtic Daylight…” ja Eneble RTC…”. 
 
Jos olet yhteydessä kanavageneraattoriin, niin synkronoi kanavageneraattorin kello painamalla ”Synchronise 
tome to…” 

3.6.3 Laskureiden märittely  

Valitse Edit=>Counter and Mux Analog Setup. 

 

Valitse ”Counter Range” -ikkunaan suurin mahdollinen luku 0...99999999 ja ”No.of Counter values” 128. 
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3.6.4 Kirjauksien määrittely 

Valitse Edit=>Mux Counters Log Set-up. 

 

Valitse tietojen kirjausväli ikkunasta Log interval. Tämä tarkoittaa mittariluennan ja kirjauksien siirron 
aikaväliä.  
Kaikki 128 osoitepaikka on esitetty ”Mux Counter Log Set-up” –ikkunassa.  
Osoitteet on jaettu neljän ryhmiin. Ensimmäinen ryhmä on 00 joka sisältää mittareiden osoitteet 0-3 tai 
laskurin 1-0 tulot (4 kpl). Toinen ryhmä on 01 joka sisältää mittareiden osoitteet 4-7 ja laskurin 1-1 tulot 
(4kpl). 
Osoitepaikan määrittely tapahtuu kaksoisnapauttamalla hiiren vasemmalla painikkeella osoitetta joka 
halutaan määritellä. Kaksoisnapautuksen jälkeen osoitepaikan ruutu muuttuu siniseksi ja on näin aktivoitu 
kirjattavaksi osoitteeksi. Täytä kohtaan ”Description” mittarin yksilöintitiedot (mittariluettelosta), kohtaan 
”Factor” laskurin / mittarin kerroin jos se on tarpeen. Mittarin virtamuuntajakerrointa ei tässä kohdassa 
tarvitse huomioida. HUOM! Järjestelmä siirtää ns. raakadataa jossa ei pilkun paikkaa ole huomioitu. Pilkun 
paikka huomioidaan tässä kertoimella. (esim.EM4 mittarilla käytetään kerrointa 10 jolloin todellinen lukema 
123,4 siirretään raakadatana 1234 ja kertoimella 10 siirretään pikku kohdalleen 123,4) (EM24 mittarilla 
lukema siirretään 1 kWh:n tarkkuudella eli kerroin on yksi ja lukema 123,7kWh on järjestelmässä 123 kWh). 
Unit Of Measure kohtaan asetetaan mitattava suure esim. kWh tai m3.  
Kun siirrytään määrittelemään seuraavaa ositepaikkaa kaksoisnapauttamalla uutta osoitetta, jää juuri 
aseteltu ruutu vihreäksi osoittamaan aktiivista osoitepaikkaa. Vain vihreänä olevat osoitepaikat luetaan 
järjestelmään. 
Kun kaikki halutut osoitepaikat on määritelty suljetaan ”Mux Counter Log Set-up” –ikkuna oikean yläkulman 
X-merkistä. 
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3.6.5 Tiedonsiirtoyhteyden määrittely 

Valitse Edit=>Communication Setup. 

 

Valitse ”COM2 Operation” ikkunaan ”Automatic Data Logging” –asetus. 

3.6.6 Kokoonpanon tallennus 

Tallenna laadittu kokoonpanotiedosto PC:lle painamalla File=>Save as. Anna tiedostolle nimi joka on muotoa 
*.x36. Tarkista, että Save as type on G38XX36 (.x36). 
 
Sulje ohjelma. 

3.6.7 Luodun kokoonpanon siirto kanavageneraattorille 

Kytke PC RS232-kaapelilla kanavageneraattorin C1 porttiin. Varmista, että kanavageneraattorilla on 
apujännite. Avaa konfigurointityökalu. Kunnossa oleva yhteys ilmaistaan vilkkuvalla vihreällä pisteellä 
kohdassa COM1. 
Avaa File=>Open ja etsi tallentamasi tiedosto ja avaa se. 
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Ennen tiedonsiirron aloittamista tarkista kanavageneraattorin päivämäärä ja kello. Jos kanavageneraattorin 
kello on väärässä ajassa, niin siirry Edit>Basic Setup ja kaksoisnapauta ”Synchronise Time to:” -painiketta 
jolloin kanavageneraattorin kello tahdistuu PC:n kellon kanssa. 
 

 
 
Valitse File=>”Write to generator” ja seuraa ohjeita. 
 

 
 
Valitse Yes jos haluat tallentaa kokoonpanon PC:lle ja siirtää kanavageneraattorille. 
Valitse No jos haluat vain siirtää kokoonpanon kanavageneraattorille. 
Valitse Cancel jos haluat peruuttaa toiminnon ilman toimenpiteitä. 
 
Odota kunnes saat ilmoituksen ”Data transferred succesfully” ja hyväksy se painamalla ok. 
 
Nyt on järjestelmäkokoonpanotiedosto siirretty kanavageneraattorille ja kirjaukset suoritetaan asetellun 
mukaisesti. 
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3.6.8 Kokoonpanotiedoston siirto palvelimelle. 

Avaa File=>Export Cconfiguration ja tallenna tiedosta haluamaasi paikkaan, josta se on siirrettävissä 
Dupline-Online  –palvelimelle. 
 

 
 
Jos tulee vikailmoitus ”Run-time error:20477” on se ilmoitus väärästä merkistä Basic Setupissa. Katso kohta 
3.6.2. 
 
Jos tulee vikailmoitus ”Run-time error:32765” poista Configurointityökalu PC:stä ja asenna se uudestaan. 
 

 
 
Jos tulee vikailmoitus ”Run-time error:13” lienee ongelma kertoimen ”Factor” desimaalierottimessa, katso 
kohta 3.6.4
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3.7 MOXA NPort 5110 -sovittimen asetukset (ETHCONV2) 

Tämä ohje perustuu MOXA Nport 5110:n käyttöön RS232 / Ethernet -sovittimena. 
 
Sovittimen konfiguroinnissa määritellään sovittimen IP-osoite sekä palvelimen IP-osoite jolle kirjatut tiedot 
lähetään kanavageneraattorilta määritellyin välein sekä toimintatapa. Sovittimen konfiguroinnin 
helpottamiseksi on www.dupline-online.com sivustolta valikosta ”Tuki” ladattavissa konfigurointityökalu 
”MOXA NPort Configuration Tool for Dupline-Online”. Tämä ohje perustuu mainitun konfigurointiyökalun 
käyttöön. Ennen ohjelmoinnin aloittamista on hyvä selvittää: 
 

 sovittimen IP-osoite 

 sovittimen verkon Subnet mask 

 sovittimen verkon Default gateway 

 Dupline-Online Serverin TCP Host (Palvelimen IP-osoite) 

3.7.1 Aloitus 

Kytke sovitin samaan Ethernet verkkoon ohjelmointiin käytettävän PC:n kanssa tai suoraan PC:n 
verkkokorttipaikkaan. Avaa konfigurointityökalu ja paina ”Search” jolloin ohjelma hakee automaattisesti 
verkosta sovittimen / sovittimet ja ilmoittaa taulukossa sovittimen IP-osoitteen / osoitteet. Konfigurointia 
varten täytyy PC:n IP-osoite muuttaa samaan osoiteavaruuteen jossa MOXA on, muutoin konfigurointia ei 
voida suorittaa. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

3.7.2 Sarjaliikenneportin asetukset 

Kaksoisnapauta riviä jolla ohjelmoitava sovitin on. Nyt avautuu seuraava ikkuna: 
 

http://www.dupline-online.com/
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Valitse ”Automatic Data Logging to a Stand-Alone Dupline-Online Server (C2)” sekä syötä TCP Host 
kenttään vastaanottavan palvelimen IP –osoite. Lisäksi TCP portti pitää määritellä kenttään ”Dupline-Online 
Server TCP port”. Oletus portti on 10100 jota yleensä ei tarvitse vaihtaa. Jos se vaihdetaan täytyy myös 
vaihtaa LogIf palvelun TCP portti Dupline-Online server sovelluksessa. 
 
MOXA NPort muuntimen sarjaliikenneportti täytyy liittää Dupline Data Loggerin porttiin C2.  
 
Valitse Apply jolloin alla seuraava ikkuna ilmaantuu ja valitse ok tai valitse suoraan välilehti ”Network 

Configuration” 

3.7.3 Verkon asetukset 

 

 

Siirry asettamaan sovittimen verkon asetuksia. 
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Host name:na suositellaan käytettäväksi laitteen tarjoamaa nimeä. 
 
Valitse verkon asetukset automaattiseksi (DHCP) tai kirjoita ne kenttiin käytettäessä kiinteitä osoitteita. 

3.8 MOXA NPort 5210 -sovittimen asetukset (ETHCONV3) 

Tämä ohje perustuu MOXA Nport 5210:n käyttöön RS232 / Ethernet -sovittimena. 
 
Sovittimen konfiguroinnissa määritellään sovittimen IP -osoite, porttien toimintatapa sekä palvelimen IP -
osoite jolle kirjatut tiedot lähetään kanavageneraattorilla määritellyin välein. Sovittimen konfiguroinnin 
helpottamiseksi on www.dupline-online.com sivustolta valikosta ”Tuki” ladattavissa konfigurointityökalu 
”MOXA NPort Configuration Tool for Dupline-Online”.  Tämä ohje perustuu mainitun konfigurointiyökalun 
käyttöön. Ennen ohjelmoinnin aloittamista on hyvä selvittää: 
 

 sovittimen IP -osoite 

 sovittimen verkon Subnet mask 

 sovittimen verkon Default gateway 

 Dupline-Online Serverin TCP Host (IP -osoite) 

3.8.1 Aloitus 

Kytke sovitin samaan Ethernet verkkoon ohjelmointiin käytettävän PC:n kanssa tai suoraan PC:n 
verkkokorttipaikkaan. Avaa konfigurointityötkalu ja paina ”Search” jolloin ohjelma hakee automaattisesti 
verkosta sovittimen / sovittimet ja ilmoittaa taulukossa sovittimen IP-osoitteen / osoitteet. Konfigurointia 
varten täytyy PC:n IP-osoite muuttaa samaan osoiteavaruuteen jossa MOXA on, muutoin konfigurointia ei 
voida suorittaa. 
 

 
 
 
 
 
 
 
 
 
 
 

http://www.dupline-online.com/
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3.8.2 Sarjaliikenneportin asetukset, Portti 1, konfigurointi 

Kaksoisnapauta riviä jolla ohjelmoitava sovitin on. Nyt avautuu seuraava ikkuna: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Valitse ”Configuration of the Dupline Data Logger (C1). Muita asetuksia portille 1 ei tarvitse tehdä. 
 

3.8.3 Sarjaliikenneportin asetukset, Portti 2, tiedonsiirto 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Valitse ”Automatic Data Logging to a Stand-Alone Dupline-Online Server (C2)” sekä syötä TCP Host tiedot –
kenttään palvelimen IP-osite. Lisäksi TCP portti pitää määritellä kenttään ”Dupline-Online Server TCP port”. 
Oletus portti on 10100 jota yleensä ei tarvitse vaihtaa. Jos se vaihdetaan täytyy myös vaihtaa LogIf palvelun 
TCP portti Dupline-Online server sovelluksessa. 
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MOXA NPort muuntimen sarjaliikenneportti 1 täytyy liittää Dupline Data Loggerin porttiin C1, 
sarjaliikenneportti 2 täytyy liittää Dupline Data Loggerin porttiin C2. 
 
 

3.8.4 Verkon asetukset 

Valitse välilehti ”Network Configuration” ja siirry tekemään sovittimen verkon asetuksia 

 

 
 
Kirjoita Host name kenttään palvelun nimi. Oletus nimenä käytetään Dupline-Online-<MOXA sarjanumero>. 
 
Valitse verkon asetukset automaattiseksi (DHCP) tai kirjoita ne kenttiin käytettäessä kiinteitä osoitteita. 

3.9 Moxa OnCell G3110 asetukset 

Tämä ohje perustuu MOXA OnCell G3110 modeemin käyttöön RS232 / Ethernet –sovittimena langattomaan 
tiedonsiirtoon. 
 
Sovittimen konfiguroinnissa määritellään sovittimen IP osoite, porttien toimintatapa sekä palvelimen IP osoite 
jolle kirjatut tiedot lähetään kanavageneraattorilla määritellyin välein. Sovittimen konfigurointi tehdään 
PC:selaimella. Ennen ohjelmoinnin aloittamista on hyvä selvittää / hankkia: 
 

 Dataliikenteen (mobiililaajakaista) SIM-kortti josta on PIN-koodi kysely poistettu. 

 Dupline-Online Serverin TCP Host (Palvelimen IP osoite, jolle tiedot lähetetään) 
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3.9.1 Aloitus 

Aseta SIM-kortti, josta PIN-koodin kysely on poistettu, paikalleen G3110 modeemin takana olevan kannen 
alle. Kiinnitä antenni paikalleen. Kytke sarjakaapeli modeemin D9-liittimestä kanavageneraattorin 
etupaneelissa olevaan porttiin C2. Kytke jännite modeemiin. 
Kytke verkkokaapeli PC:n ja OnCell G3110:n välille ja aloita kirjoittamalla modeemin IP-osoite selaimen 
osoiteriville. Vaihda PC:n IP osoite samaan osoiteavaruuteen MOXA:n kanssa, esim.192.168.127.250. 
Kirjoita selaimen osoitekenttään Moxan oletus IP 192.168.127.254 jolloin alla oleva ikkuna avautuu. 
 

 
 

3.9.2 Sarjaliikenneportin konfigurointi 

Valitse menu-valikosta ”Serial Port Settings”-> ”Port1” -> ”Communication Parameters” ja aseta portille 1 alla 
olevat arvot ja paina ”Submit”: 
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3.9.3 Toimintatilan määrittely 

Valitse menu-valikosta ”Serial Port Settings”-> ”Port” ->  ”Operation Modes” ja aseta siihen alla olevat arvot 
ja paina ”Submit”. Huomaa, että kohtaan ”Destination address 1” tulee laittaa tietoja vastaanottavan 
palvelimen osoite. (Esimerkin osoite siirtää tidot Energiakolmion plavelimelle.) 
 

 

3.9.4 Internet -määrittelyt 

Valitse menu-valikosta ”Network Settings”-> ”GSM GPRS Settings” ja aseta seuraavat arvot ja paina 
”Submit” 

 



Asennusohje  

Dupline-Online Server (DUP-SERV-SW) palvelinohjelman asennus Sivu 22 

 

 

4 DUPLINE-ONLINE SERVER (DUP-SERV-SW) 
PALVELINOHJELMAN ASENNUS 

4.1 Yleistä 

Dupline-Online palvelinohjelma on lisenssipohjainen SQL-tietokantaohjelma. Itse palvelinohjelma 
(DUP-SERV-SW) sisältää lisenssin yhden kanavageneraattorin tietojen luentaan ja tallentamiseen. 
Liitettäessä samaan palvelinohjelmaan useampia kanavageneraattoreita tulee kullekin 
lisäkanavageneraattorille hankkia laajennuslisenssi DUP-SERV-ADD. Palvelinohjelma toimii 30 
vuorokakutta ilman ohjelman lisenssin aktivointia.  
 

4.2 Laitteistovaatimukset (suositeltavat) 

 

 

4.3 Ohjelman asennus 

Dupline-Online palvelinohjelma ladataan kotisivuiltamme seuraavasta linkistä:  
 

 www.dupline-online.com ->”Tuki”->”Installation program for the Dupline-Online Server version 
1.3”.  
 

Kun ohjelma on asennettu ja käynnistynyt pienennä alla oleva ikkuna näytön alapalkkiin pitäen 
ohjelma kuitenkin käynnissä. 
 

http://www.dupline-online.com/
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1.Avaa Dupline-Online palvelinohjelma kirjoittamalla WEB-selaimen ositekenttään ”localhost”. 
2.Valitse valikkoriviltä ”Sisäänkirj”  
3.Kirjaudu sisään käyttäjätunnuksella ”admin” ja salasanalla ”dupline” 
4.Valitse ”Sisäänkirj”. 
 

 
 
Nyt avautuu ”Asetukset”-ikkuna. 
Täydennä tiedot taulukkoon ”Asetukset” ja valitse ”Tallenna”. 
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4.4 Ohjelman aktivointi 

Toimiakseen toistaiseksi (yli 30 vrk) ohjelma pitää aktivoida ohjelman valmistajan kotisivuilla 
käyttämällä joko Online- tai Offline –aktivointia.  
 
Online-aktivoinnissa on palvelimen johon palvelinohjelma on asennettu on oltava kytekettynä 
Internetiin. 
 
Offline aktivoinnissa täytyy jollain toisella tietokoneella kirjautua internetiin sivustolle www.dupline-
online.com. 
 

4.4.1 Online -aktivointi 

 
1.Siirry Online aktivointiin valitsemalla valikkoriviltä ”Aktivoida” 
2. Täytä taulukko. Tarvittaessa ”Lisenssin avaimen” voi tilata Carlo Gavazzi Oy:ltä 
3. Hyväksy järjestelmätietojen lähettäminen klikkaamalla ruutuun 
4. Valitse ”Aktivoida”-painike 
 

 
 
 
Aktivoinnin jälkeen voit tarkistaa palvelimella olevien liesenssien määrän kohdan 4.3.3 mukaan. 
 
Jos internet yhteyttä ei ole tai Online-aktivointi ei toimi niin klikkaa tekstiä ”Klikkaa tästä jos sinulla 
ei ole pääsyä internetiin tai ”online” aktivointi ei onnistu” 

http://www.dupline-online.com/
http://www.dupline-online.com/
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4.4.2 Offline -aktivointi 

 
 
Päästäksesi Offline-aktivointiin valitse Online –aktivointi sivulta ”Klikkaa tästä jos sinulla ei ole 
pääsyä Internetiin tai Online -aktivointi ei onnistu” ja seuraa Off line –aktivointi ohjeita. 
 
-Kirjoita Offline ikkunasta saatava Palveilmen ID koodi ylös 
 

 
 
-Mene www.dupline-online.com, valitse valikosta ”Palvelimen lisensssi” välilehti ”Lataa lisenssin 
aktivointitiedosto”, täydennä vaaditut kentät ja tallenna saamasi aktivointitiedosto sen siirtoa varten 
palvelimelle. Tallennus voidaan tehdä esim. USB-tikulle jolla voit siirtää sen palvelimelle kohdassa 
Offline-aktivointi. 
 

 
 
 

http://www.dupline-online.com/
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Siirry palvelinojelman kohtaan Offline-aktivointi 
 

 
 
Anna lisenssin avain ja hae www.dupline-online.com :ista hakemasi lisenssitiedosto. Lopuksi paina 
”Aktivoida” 
 
Aktivoinnin jälkeen voit tarkistaa palvelimella olevien liesenssien määrän kohdan 4.3.3 mukaan. 

http://www.dupline-online.com/
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4.4.3 Lisenssien lukumäärän tarkistus 

 
Voit tarkistaa palvelimen lisenssien määrän kohdasta ”Asetus” -> ”Palvelimet” 
 

 

4.5 Määrittelyn lataus 

Kanavageneraattorilla tehdyn ja exportatun konfiguroinnnin (määrittelyn) lataus tapahtuu 
seuraavasti: 
Valitse Dupline-Online -palvelinohjelman valikosta ”Asetus” ”Määrittelyn lataus” 
 

 
 

Hae määrittelytiedosto joka on luotu kanavageneraattorilla kohdassa 3.6.8 ja tallennettu esim. 
USB-tikulle. 
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4.6 Laajennuslisenssien lataaminen jo aktivoituun 
ohjelmaan 

Palvelimen laajennuslisenssien lataus voidaan tehdä Online- tai Offline –päivityksenä. 
 

4.6.1 Laajennuslisenssin Online -päivitys 

Palvelimen laajennuslisenssin Online –päivitys: 
1.Valitse valikosta ”Asetus” 
2.Valitse alasvetovalikosta ”Palvelimet” 
3. Paina ”Päivitys” 
 

 
   
Jos internet yhteyttä ei ole tai Online-päivitys ei toimi niin klikkaa tekstiä ”Klikkaa tästä jos sinulla ei 
ole pääsyä internetiin tai ”online” lisenssinpäivitys epäonnistui.” 
 
Päivityksen jälkeen voit tarkistaa palvelimella olevien liesenssien määrän kohdan 4.3.3 mukaan. 
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4.6.2 Laajennuslisenssin Offline –päivitys 

Siirry laajennuslisenssin Offline -päivitykseen Online sivulla olevasta linkistä ”Klikkaa tästä jos 
sinulla ei ole pääsyä internetiin tai ”online” lisenssinpäivitys epäonnistui.”  
 

 
 
Siirry osoitteeseen www.dupline-online.com ja hae päivitystiedosto seuraavasti:  
1.Valitse ”Palvelimen lisenssi”  
2.Valitse ”Lataa lisenssin päivitystiedosto” 
3.Täydennä tarvittavat tiedot. 
4. Paina ”Lataaminen” ja tallenna saamasi tiedosto sen siirtämiseksi palvelimelle. 
 

 

 

Palaa takaisin ”offline-lisenssin päivitys”-sivulle ja hae lisenssitiedosto valitsemalla ”Valitse tiedosto” ja paina 
pävitä.  

http://www.dupline-online.com/
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Päivityksen jälkeen voit tarkistaa palvelimella olevien liesenssien määrän kohdan 4.3.3 mukaan. 
 

4.7 Toiminnan tarkastus 

Voi kestää joitakin kymmeniä minuutteja ennen kuin yhteys palvelinohjelman ja 
kanavageneraattorin välillä toimii. ”Laitteet” sivulla näkyy kaikki palvelinohjelmaan tuodut 
laitemäärittelyt . Kohdassa ”Laitteen ID” on kerrottu ko. kanavageneraattorin sarjanumero johon 
perustuu datan kohdistus. Kohdassa ”lähde” on lähettävän kanavageneraattorin IP -osoite tai 
puhelinnumero riippuen lähetystavasta. Jos ko. kentässä ei ole punaista ristiä on yhteys 
kanavageneraattoriin kunnossa. Punaisen ristin ollessa IP- osoitteen päällä tarkoittaa se 
yhteysvirhettä kanavageneraattorin ja palvelinohjelman välillä. 
 
Kulutuslukemia päästään tarkastelemaan klikkaamalla ”Laitteen ID” sarakkeen vasemmalla 
puolella vihreässä neliössä olevaa valkoista nuolta. Ko. nuoli siirtyy halutun kohteen kohdalle 
klikkaamalla laitteen ID numeroa. 
 

5 YHTEYSTIEDOT 

Lisätietojen saamiseksi ota yhteyttä: 
 
Carlo Gavazzi Oy 
Petaksentie 2-4 
00630 HELSINKI 
P. +358 9 7562 000  
fax: +358 9 7562 0010 
myynti@gavazzi.fi 
www.carlogavazzi.fi 
www.dupline.com 
www.dupline-online.com 
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